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1 Introduction

The PCAN-PC/104 is a compact PC/104 CAN card which allows the
networking of one or two CAN busses to a PC/104 system. Device
drivers and programming interfaces exist for different operating
systems, so programs can easily access a connected CAN bus.

]
@/ Tip: At the end of this manual (Appendix C) you can find a
Z  Quick Reference with brief information about the installation

and operation of the PCAN-PC/104 card.

1.1 Properties at a Glance

Form factor PC/104

Multiple PC/104 cards can be operated in parallel (interrupt
sharing)

14 port and 8 interrupt addresses are available for configuration
using jumpers

1 or 2 High-speed CAN channels (ISO 11898-2)

Compliant with CAN specifications 2.0A (11-bit ID)
and 2.0B (29-bit ID)

NXP CAN controller SJA1000, 16 MHz clock frequency
NXP CAN transceiver PCA82C251

CAN bus connection via D-Sub, 9-pin (in accordance with
CiA® 102)

Bit rates up to 1 Mbit/s

Galvanic isolation up to 500 V for the CAN interface (only opto-
decoupled models), separate for each CAN channel
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5-Volt power supply at the CAN connector connectible by solder
jumpers, e.g. for external bus converter

Extended operating temperature range of -40 to +85 °C (-40 to
+185 °F)

ﬂ Note: This manual describes the use of the PCAN-PC/104 card
with Windows. You can find device drivers for Linux and the
corresponding application information on the provided CD in
the directory branch Develop and on our website under
www.peak-system.com/linux.

1.2 System Requirements

PC/104 stack with ISA bus (according to the PC/104 specification)

Operating system Windows 7/Vista/XP (32-bit),
or Windows CE 6.x (x86 and ARMv4 processor support),
or Linux (32-bit)


http://www.peak-system.com/linux�
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1.3 Scope of Supply

PCAN-PC/104 card

Slot bracket with D-Sub connector(s) for the CAN bus
connection

Device drivers for Windows 7/Vista/XP (32-bit) and Linux (32-bit)

Device driver for Windows CE 6.x
(x86 and ARMv4 processor support)

PCAN-View CAN monitor for Windows
PCAN-View CAN monitor for DOS

PCAN-Basic programming interface consisting of an interface
DLL, examples, and header files for all common programming
languages

Manual in PDF format
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2 Installing and Configuring
the Software and the cCard

This chapter covers the configuration, the software setup for the
PCAN-PC/104 card under Windows, and the card installation in the
computer.

2.1 cConfiguring the card

Before installing the PCAN-PC/104 card into the computer you may
need to configure it. For each CAN channel an interrupt (IRQ) and an
I/0 address range is set for operation in the computer.

At delivery the PCAN-PC/104 card has the following default settings:

CAN Channel IRQ 1/0 Address Range | Comment
1 10 300h - 31Fh
2 5 320h - 33Fh Dual Channel model only

]
Y -
({7 Tip: If the given resources are not permanently allocated by
Z other devices, you can skip the configuration and directly
continue with the following manual section 2.2 on page 12.

For a configuration differing from the default settings you need to
set jumpers on the PCAN-PC/104 PCB according to the following
explanations.

‘;\ Attention! Electrostatic discharge (ESD) can damage or destroy
components on the PCAN-PC/104 card. Take precautions to
avoid ESD when handling the card.
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2.1.1 Interrupt

An interrupt (IRQ) must be assigned to each CAN channel. This is
done with a single jumper on jumper field JP1 for CAN channel 1
and jumper field JP2 for CAN channel 2 (latter refers only to the
Dual Channel model). The PCAN-PC/104 card supports the inter-
rupts 3, 4, 5,7, 10, 11, 12, and 15. The default setting at delivery for
CAN channel 1 is interrupt 10, for CAN channel 2 interrupt 5.

Figure 1: Position of the jumper fields for setting the interrupts,
JP1 for CAN channel 1 (lower jumper field),
JP2 for CAN channel 2 (upper jumper field,
Dual Channel model only)

It is possible to share the same interrupt between two existing CAN
channels. Therefore you can configure the same interrupt when
using two PCAN-PC/104 cards in the same computer.

) -
((7 Tip: We suggest to configure different interrupts as long as

Z resources allow it and use interrupt sharing only if this is not
the case.
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2.1.2 I/0 Address Range

Each CAN channel must be assigned to an unique I/0 address range
in the computer. An address space from 200h up to 39Fh and 3EOh
to 3FFh (h = hexadecimal) is available. PCAN-PC/104 uses 32 addres-
ses beginning from the configured base address. The configuration
is done on jumper field JP3 for CAN channel 1 and jumper field JP4
for CAN channel 2 (latter refers only to the Dual Channel model).
One or several jumpers are needed for each jumper field.

I-

=1 s’

Figure 2: Position of the jumper fields for setting the 1/0 base addresses,
JP3 for CAN channel 1 (left jumper field),
JP4 for CAN channel 2 (right jumper field, Dual Channel model only)

The following table shows the possible settings. The X stands for a
set jumper. The default settings at delivery for CAN channels 1 and
2 are highlighted.

Continued on the next page

10
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Jumper field JP3/JP4 1/0 address range

A B Cc D

X 200h - 21Fh
X 220h - 23Fh
X X 240h - 25Fh
X X 260h — 27Fh
X X 280h - 29Fh
X X 2A0h - 2BFh
X X X 2CO0h - 2DFh
X X X 2EOh - 2FFh
X X 300h - 31Fh
X X 320h - 33Fh
X X X 340h - 35Fh
X X X 360h - 37Fh
X X X 380h - 39Fh
X X X X 3EOh - 3FFh

11
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2.2 Installing the Software and the Card

Setup the driver before inserting the card.

®» Do the following to install the driver:

1. Windows XP only: Make sure that you are logged in as user
with administrator privileges (not needed for normal use of
the PCAN-PC/104 card later on).

2. Insert the supplied CD into the appropriate drive of the
computer. Usually a navigation program appears a few
moments later. If not, start the file Intro.exe from the root
directory of the CD.

On the page English > Drivers activate the entry PCAN-ISA.

4. Click on Install now. The setup program for the driver is
executed.

5. Follow the instructions of the program.
\ -
\@ Tip: If you do not want to install the CAN monitor PCAN-View
Z for Windows onto the hard disk together with the driver, you

have the option to start the program later directly from CD
without prior installation.

®» Do the following to install the PCAN-PC/104 card in the
computer:

fm Attention! Electrostatic discharge (ESD) can damage or destroy
components on the PCAN-PC/104 card. Take precautions to
avoid ESD when handling the card.
Shut down the computer.

6. Disconnect the computer from the power supply.

7. Plug the PCAN-PC/104 card onto a PC/104 connector. For
details refer to the documentation of the computer.

12
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8. Interconnect the connector for each CAN channel on the
PCAN-PC/104 card (see Figure 3) with the CAN connector of
the slot bracket using the attached flat cable.

Figure 3: Connectors for the flat cables to the CAN connectors,
J3 for CAN channel one (lower position),
J4 for CAN channel 2 (upper position, Dual Channel model only)

9. Reconnect the power supply of the computer.

8 Note: Before switching on the computer, please follow the pro-
cedure for modifying the computer's BIOS settings described in
the following section.

2.3 Modifying the Computer's BIOS Settings

To ensure a flawless operation of the PCAN-PC/104 card it is neces-
sary that you adjust settings in the BIOS setup of the computer:

— Indicate used interrupts

 Deactivate the APIC mode

13
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ﬂ Note: Due to a diversity of existing BIOS setup versions for
computers we cannot give detailed instructions here. Instead
we indicate common setting names.

In order to know how to start the computer's BIOS setup please
consult the corresponding documentation. Usually you can enter
the BIOS setup by pressing the Del or |F2 key shortly after switching
on the computer.

2.3.1 Indicating Used Interrupts

By indicating the interrupts that are set on the PCAN-PC/104 card,
you avoid that the corresponding resources are automatically
assigned to other devices and that this results in conflicts.

In the BIOS setup itself you can often find the settings for the
interrupts under a menu item containing the text “PnP”. For the
interrupt(s) used by PCAN-PC/104 change the setting to “Reserved”
or “Legacy ISA”.

2.3.2 Deactivating the APIC Mode

€) Note: Do not mix up APIC with ACPI.

The APIC mode is a certain type of interrupt management in a
computer.

If the APIC mode is active in your computer, you must deactivate it
so that the PCAN-PC/104 card can work properly with interrupts.

®» Do the following to determine in Windows if the APIC mode is
active:

Open the Windows Device Manager.

10. Select the menu entry View > Resources by type.

14
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11. Open the branch of Interrupt request (IRQ).

If entries with interrupt numbers greater than 15 are listed,
the APIC mode is active and you must deactivate it.

®» Do the following to deactivate the APIC mode:

ﬂ Important note: When you deactivate the APIC mode in the
BIOS setup, it may happen that you must reinstall Windows
afterwards, because it cannot start anymore due to the low-
level setting.

Restart the computer and switch to the BIOS setup.
12. Search for the APIC setting and deactivate it.
13. Save the changes in the BIOS and quit the BIOS setup.

14. If Windows doesn't start properly, reinstall it or perform a
repair installation.

15
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3 Connecting the CAN Bus

3.1 D-Sub Connector

A High-speed CAN bus (ISO 11898-2) is connected to the 9-pin
D-Sub connector. The pin assignment corresponds to the
specification CIA® 102.

— +5 V (optional)
GND -—
—— CAN_L
CAN_H ——
> GND

o—

PSP

+5V (optional) -—

%%?%%

[

Figure 4: Pin assignment High-speed CAN
(view onto connector of the slot bracket)

With the pins 1 and 9 devices with low power consumption (e.g. an
external bus converter) can be directly supplied via the CAN con-
nector. At delivery these pins are not assigned. You can find a
detailed description about the activation in the following section 3.2.

16
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The pin assignment between the D-Sub port and the 10-pin connec-
tor on the PCAN-PC/104 card is as follows:

Figure 5: Numbering at the 10-pin connector

Pin Assignment (AN

D-Sub

1 +5 V (optional) 1
2 GND 6
3 CAN_L 2
4 CAN_H 7
5 GND 3
6 not connected 8
7 not connected 4
8 +5 V (optional) 9
9 not connected 5
10 not connected

]
\@( Tip: You can connect a CAN bus with a different transmission
Z standard via a bus converter. PEAK-System offers different bus
converter modules (e.g. PCAN-TJA1054 for a Low-speed CAN
bus according to ISO 11898-3).

17
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3.2 Supplying External Devices via the CAN
Cconnector

You can route a 5-Volt supply to pin 1 and/or pin 9 of the CAN con-
nector (independently for each CAN connector on the Dual Channel
model) by setting solder jumpers on the PCAN-PC/104 card. Thus
devices with low power consumption (e.g. a bus converter) can be
directly supplied via the CAN connector.

When using this option the 5-Volt supply is connected to the power
supply of the computer and is not fused separately. The opto-
decoupled models of the card contain an interconnected DC/DC
converter. Therefore the current output is limited to about 50 mA.

®» Proceed as follows to activate the 5-Volt supply:

fm Attention! Electrostatic discharge (ESD) can damage or destroy
components on the PCAN-PC/104 card. Take precautions to
avoid ESD when handling the card.

Set the solder jumpers on the PCAN-PC/104 card according to the
desired settings. During this procedure take especially care not to
produce unwanted short circuits on the card.

Figure 6 shows the positions of the solder fields on the PCAN-
PC/104 card. The table below contains the possible settings.

18
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8|

B
LT

)

o'

Figure 6: Position of the solder jumper fields for the 5-Volt supply
(JP5 lower position, JP6 upper position)

5-Volt supply — .~ None | Pin 1 \ Pin9 | Pin1+Pin9

JP5 (CAN channel 1) / ) Ll 9
JP6 (CAN channel 2)

v w

A Attention! Risk of short circuit! If the option described in this
section is activated, you may only connect or disconnect CAN
cables or peripheral systems (e.g. an external bus converter) to
or from the PCAN-PC/104 card while the computer is de-
energized.

19



PCAN-PC/104 - User Manual

System

3.3 cCabling

3.3.1 Termination

A High-speed CAN bus (ISO 11898-2) must be terminated on both
ends with 120 Ohms. Otherwise, there are interfering signal reflec-
tions and the transceivers of the connected CAN nodes (CAN inter-
face, control unit) will not work.

The PCAN-PC/104 card does not have an internal termination. Use
the adapter on a terminated CAN bus.

3.3.2 Example of a Connection
Terminated cable
PC [ | Control device
CAN-Interface

Figure 7: Simple CAN connection

In this example, the PCAN-PC/104 card is connected with a control
unit by a cable that is terminated at both ends.

20
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3.3.3 Maximum Bus Length

High-speed CAN networks may have bit rates of up to 1 Mbit/s,
where all CAN nodes must be able to process messages simultane-

ously. The maximum bus length is primarily depending on the bit
rate.

The following table shows the maximum CAN bus length at diffe-
rent bit rates:

Bit rate Bus length
1 Mbit/s 40 m

500 kbit/s 110 m

250 kbit/s 240 m

125 kbit/s 500 m

50 kbit/s 1.3 km

20 kbit/s 3.3km

10 kbit/s 6.6 km

5 kbit/s 13.0 km

The listed values have been calculated on the basis of an idealized
system and can differ from reality.

21
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4 Using the Software

This chapter covers the provided software PCAN-View and the
programming interface PCAN-Basic.

4.1 PCAN-View for windows

PCAN-View for Windows is a simple CAN monitor for viewing,
transmitting, and logging CAN messages.

jew Tace  Help
Dojenmo0
/Transmit | =2 Trace| & PCAN-USB

ata

CycleTime  Count

18FECONN 0 0077 70 000000 0000 1001 103
16FEC10N 6800 000000000000 1001 103
SN 0000 000000 000000 1001 103
> |1sFEE900h 00.00.00.00 000000 00 1001 103
2200000000 000000 a5 06
56.65 66 69 63 6C 65 31 10
28 00 00 00 00 00 00 00 o
0058 16 01000000 00
00,0000 0000 0 00

X Internal

i BWO0LLOILONL00  Wait 0
4 B9 PEAKPCI-CAN 5t PCT Bus 4, Device 1, Channel 1 2 1801 @100 i
A PCI125K (125 kBit/s) 2 100 @ 482,
¥ PCLZS0K Q250 kBiY/s) 0 00010001 Wait )

5 PCIS00K (500 1

@ PCAN-USE ro:De
& PCAN-USE P
& PCAN-USE:

b5 GivB & Overnst Qe |

Bitrote: 500 KBit/s v Bus timing register value (He: 101

Bxtended (i) (i)
(o) (o) (@)

Figure 8: PCAN-View for Windows

®» Do the following to start and initialize PCAN-View:

1. If PCAN-View is already installed on the hard disk, open the

Windows Start menu, go to Programs > PCAN-Hardware,
and select the entry PCAN-View.

22
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If you haven't installed PCAN-View together with the device
driver, you can start the program directly from the supplied
CD. In the navigation program (Intro.exe) go to English >
Tools, and under PCAN-View for Windows select the link
Start.

The dialog box for selecting the CAN hardware and for
setting the CAN parameters appears.

= Connect =0 X |

Awailable CAM hardware and PCAN-nets:

=9 PCAMN-PCLat PCI Bus 4, Device 1, Channel 1

Bit rate: [ 500 KBit/s | Bustiming register value (Hex): 001C
essage filter

4 From: 100 (Hex) Tos TFF et

[ ok ][ concel |[ G Help |

Figure 9: Selection of the CAN specific hardware and parameters

If there is no entry in the list Available CAN hardware (for example
at the first program start), you need to add one:

Run PCAN-View with administrator privileges (Windows XP:
user login with corresponding privileges, Windows Vista
and 7: via the context menu of PCAN-View's Start menu

entry).
2. Click on the Add button.
The dialog box Add CAN hardware appears.

23
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Add CAN Hardware X

Description:

Adds a PCAN-ISA card, which is compatible with -
the CAN 2,04 protocol (11-bit CAN-IDs).

170 Address: -

Interrupt: 7

(o [ cancel | [@ Hep |

Figure 10: Selection of the hardware

3. Select the connected hardware and the operating mode
from the list Type of CAN hardware, in this case PEAK ISA-
CAN SJA.

4. Enter the I/0 Address and the Interrupt, as they are set on
the PCAN-PC/104 card (see section 2.1 Configuring the Card
on page 8).

Default setting on the card at delivery:

CAN IRQ 1/0 Address Range | Comment

Channel

1 10 300h - 31Fh

2 5 320h - 33Fh Dual Channel model only

5. Confirm your input with OK.

6. From the list Available CAN hardware select the CAN
channel to be used.

7. Select the Bit rate that is used by all nodes on the CAN bus.

8. Under Filter settings you can limit the range of CAN IDs to
be received, either for standard frames (11-bit IDs) or for
extended frames (29-bit IDs).

9. Finally confirm the settings in the dialog box with OK. The
main window of PCAN-View appears (see Figure 11).

24
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4.1.1 Receijve/Transmit Tab
=4 PCAN -View = 5 S
File  Client  Edit  Transmit  Miew Trace Help
= = # B @ & 0
== Receive / Transmit | =] Trace
B Message DLC Data Cycle Tirne Count
18F00300k L 00930000 00000000 49 1443 -
18F00400k L 00000030 78 00 00 00 19 3618
g 13FDD100k 8 00000205 01000000 11922 ]
T 18FEECO0N 8 0213 000400008352 49 1445
8 18FECO00R L 0009 70 0000 00 00 00 993 71
of 1EFEC100h 8 CO9 5F 0100000000 00 999 71
18FEES00R 2 00000000 00000000 o0 71
18FEES00K L 0000000053 000000 1000 71 i
O Message DLC Data Cycle Time Count Trigger
O0FFALTTh 4 oooionnl ait 17 Manual
- 00FFBBTTHh 8 AD 56 48 94 Th D6 C6 BD V125 208 Tirne
E OOFFCCTTh 8 T6 65 55 00 56 00 65 00 V|5 4558 Tirne
L]
=
1
| -
'_
@D Connected to PCAMN-PCI (500 kBit/s) B Owerruns: 0 ClrmtFull: 0

Figure 11: Receive/Transmit tab

The Receive/Transmit tab is the main element of PCAN-View. It
contains two lists, one for received messages and one for the
transmit messages. Representation of CAN data is in hexadecimal

format.

®» Do the following to transmit a CAN message with PCAN-View:

Select the menu command Transmit > New Message

(alternatively i1 or Ins).

The dialog box New Transmit Message is shown.

25
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Mew transmit message S

1D (Hex: DLC: Data (0.7

FRAATT § = 1a A 25 B6 (3 12 AL IF

Gyela iy Message Type
121 Lk | Extended Frarme
Paused Remote Request

[ Ok ] | Cancel | | (@ Help |

Figure 12: Dialog box New transmit message

10. Enter the ID and the data for the new CAN message.

11. The field Cycle Time indicates if the message shall be

System

transmitted manually or periodically. If you want to transmit

the message periodically, you must enter a value greater

than 0. For a manual-only transmission enter 0.
12. Confirm the entries with OK.

The created transmit message appears on the
Receive/Transmit tab.

13. You trigger selected transmit messages manually with the
menu command Transmit > Send (alternatively Space bar).

The manual transmission for CAN messages being

transmitted periodically is carried out additionally.

]
~

=

@ Tip: Using the menu command File > Save the current transmit

messages can be saved to a list and loaded for reuse later on.

26
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4.1.2

Trace Tab

System

File Client Edit

.

=

g

Transmit  Miew Trace

2 ot @Il | &0

r:f Receive [ Transmit E‘iﬂ!’

1 Ring Buffer

Tirne:

5394616
539,4797
539,5002
539,5109
539,5113
539,5116
539,5207
539,5402
539,5598
539,5627
539,5633
539,5803
539,5095
539,6115
539,6123
539,6126
539,6203
539,6399

Type
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data
Data

i)

16FO0400
18F00400
18F00400
18FEFLOD
18F00300
18FERCOD
18F00400
18F00400
18F00400
16F00300
18FERCOD
16F00400
18F00400
18FEFLOD
18F00300
18FEGCOD
18F00400
18F00400

Data

000000 73 65 00 0000
000000 73 65 00 0000
000000 73 65 00 00 00
00 14 33 0000 00 00 00
0000 000000 00 0000
000000000000 14 33
000000 73 65 00 00 00
000000 73 65 00 00 00
00 00 00 73 65 00 00 00
0000 000000 00 0000
000000000000 1433
000000 73 65 00 0000
000000 73 65 00 0000
00 14 33 0000 00 00 00
0000 000000 00 0000
000000000000 14 33
000000 73 65 00 00 00
00 00 00 73 65 00 00 00

@D Connected to PCAN-PCI (500 kBit/s) B# Owerruns: 0

Q¥rmtFull: 0

Figure 13: Trace tab

On the Trace tab the data tracer of PCAN-View is used for logging

the communication on a CAN bus. During this process the CAN

messages are cached in the working memory of the PC. Afterwards

they can be saved to a file.

The tracer can be configured to run in linear or in ring buffer mode.
In linear buffer mode the logging is stopped as soon as the buffer is

filled completely. In ring buffer mode the oldest messages are
overwritten by incoming ones.

27
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4.1.3 Status Bar

@ Connected to PCAR-PCI (500 kBit/s) B Owverruns: 0 Q¥mtFull: 0

Figure 14: Display of the status bar

The status bar shows information about the current CAN connec-
tion, about error counters (Overruns, QXmtFull), and shows error
messages.

You can find further information about the use of PCAN-View in the
help which you can invoke in the program via the Help menu or
with the |F1| key.

28
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4.2 Linking Own Programs with PCAN-Basic

Figure 15: PCAN-Basic

On the provided CD you can find files of the programming interface
PCAN-Basic in the directory branch Develop. This APl provides ba-
sic functions for linking own programs to CAN interfaces by PEAK-

System and can be used for the following operating systems:

Windows 7/Vista/XP (32/64-bit)

Windows CE 6.x (x86/ARMv4)
The APl is designed for cross-platform use. Therefore software pro-
jects can easily ported between platforms with low efforts. PEAK-
System has created examples for the following programming

languages: C++, C#, C++/CLR, Visual Basic, Delphi, Python, and
Java.

29
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4.2.1 Features of PCAN-Basic

Supports Windows 7/Vista/XP (32/64-bit) and Windows CE 6.x
operating system

Multiple PEAK-System applications and your own can be
operated on a physical CAN channel at the same time

Use of a single DLL for all supported hardware types

Use of up to 8 channels for each hardware unit (depending on
the PEAK CAN interface used)

Simple switching between channels of a PEAK CAN interface
Driver-internal buffering of 32,768 messages per CAN channel

Precision of time stamps on received messages up to 1 us
(depending on the PEAK CAN interface used)

Access to specific hardware parameters, such as listen-only
mode

Notification of the application through Windows events when a
message is received

Extended system for debugging operations
Multilingual debugging output
Output language depends on operating system

Debugging information can be defined individually
An overview of the API functions is located in the header files. You
can find detailed information about the PCAN-Basic API on the

provided CD in the text and help files (file name extensions . txt
and .chm).

30
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4.2.2 Principle Description of the API

The PCAN-Basic APl is the interface between the user application
and device driver. In Windows operating systems this is a DLL
(Dynamic Link Library).

The sequence of accessing the CAN interface is divided into three
phases:

1. Initialization

2. Interaction

3. Completion

Initialization

A CAN channel must be initialized before using it. This is done by
the simple call of the function CAN Initialize. Depending on the
type of the CAN hardware, up to eight CAN channels can be opened
at the same time. After a successful initialization the CAN channel is
ready for communication with the CAN hardware and the CAN bus.
No further configuration steps are required.

Interaction

For receiving and transmitting CAN messages the functions

CAN Read and CAN Write are available. Additional settings can be
made, e.g. setting up message filters to confine to specific CAN IDs
or setting the CAN controller to listen-only mode.

When receiving CAN messages, events are used for an automatic
notification of an application (client). This offers the following
advantages:

The application no longer needs to check for received messages
periodically (no polling).

The response time at reception is reduced.
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Completion

To end the communication the function CAN Uninitializeis
called in order to release the reserved resources for the CAN chan-
nel, among others. In addition the CAN channel is marked as "Free"
and is available to other applications.

4.2.3 Notes about the License

Device drivers, the interface DLL, and further files needed for linking
are property of the PEAK-System Technik GmbH and may be used
only in connection with a hardware component purchased from
PEAK-System or one of its partners. If a CAN hardware component
of third-party suppliers should be compatible to one of PEAK-
System, then you are not allowed to use or to pass on the driver
software of PEAK-System.

If a third-party supplier develops software based on the PCAN-Basic

and problems occur during the use of this software, consult the
software provider.
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5 Technical Specifications

Connectors
PC/104 ISA bus with 8 MHz clock rate, 16 bit bus width
CAN D-Sub (m), 9 pins
Pin assignment according to specification CIA® 102
CAN
Specification ISO 11898-2, High-speed CAN
2.0A (standard format) and 2.0B (extended format)
Bit rates 5 kbit/s - 1 Mbit/s
Controller NXP SJA1000
Transceiver NXP PCA82C251
Galvanic isolation PCAN-PC/104: none
PCAN-PC/104 opto: up to 500 V, separate for each CAN
channel
Supplying external PCAN-PC/104: D-Sub pin 1/9; 5 V, max. 100 mA
devices PCAN-PC/104 opto: D-Sub pin 1/9; 5 V, max. 50 mA
Not assigned at delivery
Termination none

Power supply

Supply voltage 5V
Current consumption PCAN-PC/104 Single Channel: max. 150 mA
PCAN-PC/104 Dual Channel: max. 170 mA

PCAN-PC/104 Single Channel opto: max. 210 mA
PCAN-PC/104 Dual Channel opto: max. 270 mA

Continued on the next page
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Environment

Operating temperature -40 - +85 °C (-40 - +185 °F)

Temperature for storage -40 - +125 °C (-40 - +257 °F)
and transport

Relative humidity 15 - 90 %, not condensing

EMC EN 55024:2003-10
EN 55022:2008-05
EC directive 2004/108/EG

Measures
Size 96 x 91 x 24 mm
(see also dimension drawing Appendix B on page 36)
Weight PCAN-PC/104 Single Channel: 579
PCAN-PC/104 Dual Channel: 63g

PCAN-PC/104 Single Channel opto: 59g
PCAN-PC/104 Dual Channel opto: 659

34



| PCAN-PC/104 - User Manual =

System

Appendix A CE Certificate

PCAN-PC/104 IPEH-002054/55/56/57 — EC Declaration of Conformity
PEAK-System Technik GmbH

System
Notes on the CE Symbol c €

The following applies to the PCAN-PC/104 products
IPEH-002054/55/56/57

EC Directive This product fulfills the requirements of EC directive
2004/108/EG on “Electromagnetic Compatibility” and is
designed for the following fields of application as per the
CE marking:

Electromagnetic Immunity

DIN EN 55024, Publication date: 2003-10

Information technology equipment, immunity characteristics — Limits and methods of
measurement (IEC/CISPR 24:1997, modified + A1:2001 + A2:2003);

German version EN 55024:1998 + A1:2001 + A2:2003

Electromagnetic Emission

DIN EN 55022, Publication date: 2008-05

Information technology equipment — Radio disturbance characteristics — Limits and methods
of measurement (IEC/CISPR 22:2005, modified + A1:2005);

German version EN 55022:2006 + A1:2007

Declarations of In accordance with the above mentioned EU directives,

Conformity the EC declarations of conformity and the associated
documentation are held at the disposal of the competent
authorities at the address below:

PEAK-System Technik GmbH
Mr. Wilhelm
Otto-Roehm-Strasse 69

64293 Darmstadt

Germany

Phone: +49 (0)6151 8173-20

Fax:  +49 (0)6151 8173-29
E-mail: info@peak-system.com

Vo b

Signed this 4™ day of October 2011
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Dimension Drawing

95.88 (mm
- e
»5.08 (F;) 5._38 Cpm)
oV o ¥
2 €
A~ 4@ > ©
EX - w 3
& w N El
H
o o)
o
N
87 &
N z
A3 3
3
3
o
»
Y ®
3 - -
v @ 8 © © g’O
N N
40.46 (mm 20.02 (mm>=>{1€-20.02 (mm>—>{
=
1.05 (mm)
¥
= o
~ = 96 0o 0 0 0 1 9o oo oo 1
ES 2 10¢ o o o o 2 100 o o o o 2 o
< | E N
s
] r

©
©
E}
El

Figure 16: View PCAN-PC/104

The figure does not show the actual size of the product.
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Appendix C Quick Reference

Default setting at delivery

CAN Channel |IRQ I/0 Address Range | Comment
1 10 300h - 31Fh
2 5 320h - 33Fh Dual Channel model only

software/Hardware Installation under windows

Before installing the PCAN-PC/104 card in the PC/104 stack, please
setup the corresponding software package from the supplied CD
(with administrator privileges). After switching on the computer
enter the BIOS setup. In the PnP table mark the interrupts used by
the PCAN-PC/104 card as reserved.

Getting Started under windows

Run the CAN monitor PCAN-View from the Windows Start menu as
a sample application for accessing the PCAN-PC/104 card. For
initialization of the card, indicate the parameters (I/O base address,
interrupt) and select the CAN connection and the CAN bit rate.

CAN connector (D-Sub, 9-pin)

Y +5V (optional,
. 6. 1T (optional)
GND—T0 2l cantL
7 ) -
CANH——r0 3
g O=1—GND
. g O T1T—
+5V (optional) —20 5
-« —
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